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Important User Information
Solid state equipment has operational characteristics differing from those of electromechanical equipment. Safety Guidelines 
for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from your local 
Rockwell Automation sales office or online at http://literature.rockwellautomation.com) describes some important differences 
between solid state equipment and hard-wired electromechanical devices. Because of this difference, and also because of the 
wide variety of uses for solid state equipment, all persons responsible for applying this equipment must satisfy themselves 
that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the 
use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability 
for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Rockwell Automation, Allen-Bradley, TechConnect, PanelView, RSLogix 500, and MicroLogix are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING
Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may 
lead to personal injury or death, property damage, or economic loss.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

ATTENTION Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic 
loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence

SHOCK HAZARD Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

BURN HAZARD Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures.

http://literature.rockwellautomation.com
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf


Where to Start

Connected Components Building Block Outline

Follow the path below to complete your connected components building block.

Bool and Real Memory 
Area Definition

(Standard Alarm Handling) 

Bool and Real Tags for Alarm
Symbols and Descriptions

PanelView Component
Terminal

Alarm Bool
and 

Real Tags

MicroLogix Controller

Alarm Setup

Bool and Real Tags

Alarm History 
Screen

Memory Definition and
MicroLogix Code

(Maintained Alarm Handling) 

Chapter 1 Alarm 
Coordination Integration

Chapter 2 System 
Validation and Application 

Tips

Connected Components 
Building Blocks, publication 

CC-QS001
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Preface

About This Publication

This quick start is designed to provide the necessary information to implement alarm handling. 
It’s goal is to show an easy-to-follow, structured alarm-handling template for connected 
components building block users. The Alarm Coordination Building Block is an add-on 
component, which can be used with some existing projects.

To assist in the design and installation of your system, application files and other information are 
provided on the Connected Components Building Blocks Overview CD, publication CC-QR001. 
The CD provides bills of materials (BOM), CAD drawings for panel layout and wiring, control 
programs, Human Machine Interface (HMI) screens, and more. With these tools and the built-in 
best-practices design, the system designer is free to focus on the design of their machine control 
and not on design overhead tasks.

The beginning of each chapter contains the following information. Read these sections carefully 
before beginning work in each chapter:

• Before You Begin - This section lists the steps that must be completed and decisions that 
must be made before starting that chapter.

• What You Need - This section lists the tools that are required to complete the steps in the 
current chapter. This includes, but is not limited to, hardware and software.

• Follow These Steps - This illustrates the steps in the current chapter and identifies which 
steps are required to complete the examples.

IMPORTANT Use the Alarm Coordination Connected Components Building Block Quick Start in conjunction with 
the Connected Components Building Blocks Quick Start, publication CC-QS001.

Refer to Additional Resources on page 8 for a listing of quick starts.
7Publication CC-QS009A-EN-P - March 2009 7
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Preface        
Conventions

Additional Resources

Convention Meaning Example

Check or uncheck To activate or deactivate a checkbox. Check Disable Keying.

Click Click the left mouse button once while the cursor is positioned 
on object or selection. Click Browse. 

Double-click Click the left mouse button twice in quick succession while the  
cursor is positioned on object or selection. Double-click the application icon. 

Expand Click the + to the left of a given item /folder to show its 
contents. Expand 1768 Bus under I/O Configuration.

Right-click Click the right mouse button once while the cursor is positioned 
on object or selection. Right-click the 1768 Bus icon. 

Select Using the mouse to highlight a specific option. Select the New Module folder.

Press Pressing a specific key on the keyboard or button on a 
touchscreen. Press Enter.

> Use this symbol to indicate the sub-menu name. Choose File>Menu>Options. 

Resource Description

Connected Components Building Blocks Quick Start, publication 
CC-QS001

Provides information on how to select products and gain access 
to panel and wiring information.

Connected Components Building Blocks Overview CD, publication 
CC-QR001

Provides files for the Connected Components Building Blocks.

MicroLogix 1100 Programmable Controllers User Manual, publication 
1763-UM001

Provides information on using the MicroLogix 1100 
Programmable Controller.

MicroLogix 1400 Controller User Manual, publication 1766-UM001 Provides information on using the MicroLogix 1400 
Programmable Controller.

PanelView Component Operator Terminals User Manual, publication 
2711C-UM001

Provides information on using the PanelView Component HMI 
Terminals.

http://www.ab.com Provides access to the Allen-Bradley website.

http://rockwellautomation.com/knowledgebase Provides access to self-service support.

http://rockwellautomation.com/components/connected/blocks.html Provides access to the Connected Components website.
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Chapter 1

Alarm Coordination Integration

Introduction

This Quick Start shows two approaches:

• Standard alarm handling

• Maintained alarm handling

In the standard approach, an alarm banner appears immediately after the alarm occurs. Once you 
acknowledge the alarm, the notification disappears even if the alarm bit it still set. 
Acknowledging an alarm does not clear the cause of the alarm.

In the maintained approach, you are only notified when the alarm occurs. If the alarm bit remains 
set, the ‘Show Alarms’ button continues to blink to indicate that the alarm sources are still active 
even after you acknowledge the alarm.

This chapter provides information on implementing alarm handling into your application from 
the controller side. You will create binary and real files by using RSLogix 500 software as a place 
for alarm-related data exchange.

For the Standard approach, you will create an Excel spreadsheet containing alarm addresses, 
alarm symbols, and their descriptions. You will import this spreadsheet into RSLogix 500 
software, an additional step that simplifies the process of inserting alarm-related variables. For the 
Maintained approach, you will import some MicroLogix program code, which contains the binary 
and real files for the alarm-related data and also some logic for alarm handling. This eliminates 
the need to create the binary and real files, as in the Standard approach.
9Publication CC-QS009A-EN-P - March 2009 9



Chapter 1       Alarm Coordination Integration
Before You Begin

• Review the Connected Components Building Blocks Quick Start, publication CC-QS001, 
verifying that you have completed the hardware design and installation as well as software 
installation.

• Run the Alarm Handling Demo to observe the difference in alarm behavior.

1. Load the Alarm_Handling_Demo.RSS application to your MicroLogix controller. 
MicroLogix 1100 and MicroLogix 1400 versions are available on the CD.

2. Load the Alarm_Handling_Demo.cha application to the PanelView Component terminal.

3. Toggle bits B3:0/0 B3:0/1, and B3:0/2, observing the Standard alarm handling behavior.

4. Clear bits B3:0/0 B3:0/1, and B3:0/2, as well as the bits used in the B150 file.

5. Switch to Maintained alarm handling on the PanelView Component terminal.

6. Toggle bits B3:0/3 B3:0/4, and B3:0/5, observing the Maintained alarm handling behavior.

• Select the appropriate solution for your application.

What You Need

• Personal computer
• Microsoft Excel software
• Internet Explorer version 7 or Mozilla Firefox version 2.0 software
• RSLogix 500 software, version 8.10 or later
• Connected Components Building Blocks Overview CD, publication CC-QR001
• MicroLogix 1100 or 1400 controller
10 Publication CC-QS009A-EN-P - March 2009
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Alarm Coordination Integration        Chapter 1
Follow These Steps

Follow these steps to create an alarm handling template on the controller side.

Create Files for Alarm Data Exchange (Standard Alarm Handling Approach)

In this building block, the B150 binary file named ALARM STS is used for notification that an 
alarm has occurred. Every device has a reserved 2 x 16 area (bit-wise). Every bit represents one 
alarm. When an alarm occurs, the related bit is set. The bit arrangement in the assigned area for a 
particular device depends on the application designer’s preference. The file organization is 
shown below.

ALARM STS Data File Organization

Bits Description

B150:0…B150:99 Alarm words reserved for 50 devices

B150:100 Alarm related bits going from the PanelView Component terminal to the controller

B150:101 Alarm related bits going from the controller to the PanelView Component terminal

Start

Create Files for Alarm Data 
Exchange (Standard Alarm 

Handling Approach) on page 11.

Import Files for Alarm Data 
Exchange (Maintained Alarm 

Handling Approach) on page 13.

Import Symbolic Names and 
Descriptions of Alarm Data on 

page 16.

Configure Your Web Browser to 
Work with PanelView Explorer on 

page 17.
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Chapter 1       Alarm Coordination Integration
In some cases, you may also need to use the real (float) values memory area F151, named ALARM 
VAL (Alarm Values). These memory locations are dedicated to store process values like speed and 
temperature. If necessary, these values can be shown in alarm messages as embedded variables. 
The ALARM VAL area starts at F151:0 and finishes at 151:249. It is dedicated for 50 devices, with 5 
values per device.

Follow these steps to create the alarm handling memory areas.

1. Create a new binary data file B150 and name it 
ALARM STS.

2. Create new float data file F151 and name it 
ALARM VAL.

Go to Import Symbolic Names and Descriptions of 
Alarm Data on page 16 to link your alarm sources to 
the B150 file that holds the alarm data.
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Alarm Coordination Integration        Chapter 1
Import Files for Alarm Data Exchange (Maintained Alarm Handling Approach)

This part of the Quick Start is for users who have chosen the Maintained alarm handling 
approach. The code is written for a MicroLogix 1400 controller. The instructions at the end of this 
section address changing the controller type for those using a MicroLogix 1100 controller.

In this approach, two binary data files, B150 and B151, are used. File B150 is set up identical to 
the file used in the standard approach and is similarly linked to the appropriate alarm tags on the 
PanelView Component terminal. Additionally, a B151 file, named ALARM CPY, is created. In this 
approach, when an alarm occurs, the related bit in file B151 is set. The imported code performs a 
bitwise OR operation into the whole alarm area (B151:0…B151:99) of the B151 file. If any alarm 
occurs, the B151:101/0 bit is set. This bit is used by the PanelView Component terminal to 
indicate that an alarm has occurred. The indication can be a blinking button, as shown in the 
Alarm Handling Demo example.

• If no alarm occurs, a green button reading ‘No Alarms’ is visible.
• If the alarm occurs, the button flashes red and reads ‘Show Alarms’.
• Pressing the ‘Show Alarms’ button sets the B151:100/0 bit, which causes the content of the 

B151 ALARM CPY file to be copied to the B150 ALARM STS file.
• An alarm banner appears on the display.

Once you have removed the cause of the error, return to the operator panel and press Show 
Alarms. The button returns to the ‘No Alarms’ state.

If an alarm source remains active, the relevant bits stay latched in the B151 file and you are 
notified by the blinking Show Alarms button.

In the Maintained alarm handling approach, three files are used.

• B150 - ALARM STS file
• B151 - ALARM CPY file
• F152 - ALARM VAL file

As in the Standard alarm handling approach, the F152 file is used to store process values. These 
values can be used as embedded variables in alarm messages.

IMPORTANT Alarm code should use Output Latch (OTL) instructions to avoid losing transient errors. Write your 
program code to manage the B150 file to unlatch the appropriate bits once the cause of an alarm 
has been removed.
Publication CC-QS009A-EN-P - March 2009 13



Chapter 1       Alarm Coordination Integration
Follow these steps to import the files used for alarm data exchange together with the MicroLogix 
controller program code.

1. Open your MicroLogix controller project.

2. Make sure that the data files B150, B151, and F152 are not being used.

3. Make sure that program file 250 is not being used. 

4. If any of the files mentioned above are being used, rearrange your file order.

5. Select any rung in your Main file and right-click the 
rung.

6. Choose Paste from SLC Library.

7. Browse to the file named ‘Alarm_Handling_SLC’ in 
the Maintained Alarm Handling Code folder.

8. Select the file and click Open.

9. Make sure that all import options are set as shown 
here.

10. Click OK.

11. Click OK when 
the system 
warning appears.
14 Publication CC-QS009A-EN-P - March 2009



Alarm Coordination Integration        Chapter 1
12. Click OK for any ‘Overwrite’ messages.
The program file LAD 250 ALRM HANDL and data files B150 ALARM STS, B151 ALARM CPY, 
F152 ALARM VAL are now present in the project tree.

13. Click Verify Project 

If your controller is a MicroLogix 1400, the 
verification should be successful. If your 
controller type is different, these errors may 
occur. They are caused by a mismatch 
between your application and the imported 
Alarm Handling library.

Follow these steps to correct the errors.

1. Double-click Controller Properties.

2. Change the Processor Type 
to MicroLogix 1400 Series A.

3. Click Apply and then OK to 
confirm the change.

4. Change the Processor Type 
back to the type in your 
application, for example, 
MicroLogix 1100.

5. Click Apply and then OK to 
confirm the change.

The project should now 
verify without any errors.

6. Adapt the alarm handing example to your application by creating the appropriate links to 
the B151 file.
Publication CC-QS009A-EN-P - March 2009 15



Chapter 1       Alarm Coordination Integration
Import Symbolic Names and Descriptions of Alarm Data

The bits in binary file B150 ALARM STS together with the values in the real file ALARM VAL (F151 
for standard or F152 for maintained approach) constitute data that describes every possible kind 
of alarm in a building block application. Symbolic names of bits and real values along with their 
descriptions can be either inserted manually or imported from an Excel spreadsheet.

Follow these steps to import symbolic names and descriptions from a spreadsheet.

1. Prepare an Excel spreadsheet 
that describes alarm bits as 
shown in this example.

• column A = address
• column B = blank
• column C = symbolic 
description

• column D = blank
• column E = description (first row)
• column F = description (second row)

2. Save the Excel spreadsheet as a .csv file.

3. Import the spreadsheet into your RSLogix 500 project.

a. Open your MicroLogix controller project.

b. From the Tools menu, choose Database>ASCII Import.

c. Choose Import Source Format as CSV File.

d. Make sure Addr/Symbol Desc. is selected in the Data to be Imported checkbox.

e. Click OK.

f. Browse to your .csv file and click Open.

After importing the symbolic names and 
descriptions, your binary file should 
look like the example shown here.

In the RSLogix 500 program, every 
alarm bit and real variable used should 
have a symbolic name and description.
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Alarm Coordination Integration        Chapter 1
Configure Your Web Browser to Work with PanelView Explorer

PanelView Explorer is a web-browser application for designing and managing PanelView 
Component HMI applications. For optimal performance, user a Firefox version 2.0 or Internet 
Explorer version 7 web browser. Internet Explorer version 6 is supported but not recommended.

You must set up your web browser to enable cookies, disable your pop-up blocker, and set the 
PanelView Component terminal as a trusted site within Internet Explorer. You also need to enable 
your browser to access the Windows clipboard so that you can copy and paste data from Excel 
spreadsheets or text documents. If you do not make these changes, your data will not paste into 
the Excel spreadsheet.

Update Your Firefox Browser Configuration

Follow these steps to configure your Firefox browser.

1. Open your browser.

2. Type the URL about:config.

3. Look for the preference name ‘signed.applets.codebase_priniciple_support’.

4. If the preference name exists, go to step 7.

5. If the preference name does not exist, right-click in the main window and choose 
New>Boolean.

6. Type the name signed.applets.codebase_priniciple_support.

7. Type true for the Value.

Update Your Internet Explorer Browser Configuration

You must enable copy and paste functionality as well as add the PanelView Component terminal 
as a trusted site in Internet Explorer.

From the Tools menu, choose Internet Options>Security to access the settings for the Windows 
clipboard.
Publication CC-QS009A-EN-P - March 2009 17



Chapter 1       Alarm Coordination Integration
The Internet, Local intranet, and Trusted sites have custom settings for clipboard access. The 
options are Disable, Enable, or Prompt. Enable is the recommended option for this building 
block.

Follow these steps to set up the PanelView Component terminal or emulator you are working 
with as a Local intranet or Trusted site.

1. Launch your Internet Explorer browser.

2. From the Tools menu, choose Internet Options.

3. Choose the Security tab.

4. Click Local intranet and then Custom Level.

5. In the Security Settings dialog, scroll down to Scripting.

6. For Internet Explorer 7, click Enable under Allow Programmatic clipboard access.

7. For Internet Explorer 6, click Enable under Allow paste operations via script.

8. Click Local intranet and then Sites.

9. Click Advanced.

10. In the Add this Web site to the zone field, type the IP Address of your PanelView 
Component terminal, in the format http://192.168.100.20.

11. Click Add.

12. Click OK until you exit the Internet Options dialog box.

Setting Description

Disable Copy and paste operations between PanelView Explorer and Windows applications are limited to a single input 
element, for example, the tag name in a Tags view.

Enable Copy and paste operations between PanelView Explorer and external Windows applications work as expected 
provided the range of copied data compatible with the target application into which you are pasting. 

Prompt You are prompted every time you attempt a copy and paste operation involving the state editor. In Internet Explorer 
version 6, the prompt indicates paste for both copy and paste operations. 

TIP When pressing Ctrl+v to paste data into a single cell, such as tag name, the input cell loses focus 
when you click in the prompt confirmation dialog. The ‘v’ character is pasted into the cell instead 
of the copied data. Internet Explorer version 7 does not prompt in this case.
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Chapter 2

System Validation and Application Tips

Introduction

In this chapter, you validate that communication is occurring as intended between the MicroLogix 
controller and the PanelView Component terminal. Next, you import an alarm screen and 
configure the PanelView Component application to work with the alarms you configured in the 
first chapter. Lastly, you verify that alarm handling functionality is working according to your 
needs.

Before You Begin

• Verify that the MicroLogix controller and the PanelView terminal have power applied to 
them.

• Review the Connected Components Building Blocks Quick Start, publication CC-QS001, 
verifying that you have completed all of the steps in Chapter 3 of that publication.

• Verify that you have completed all of the steps in Chapter 1 of this document.

What You Need

• Personal computer
• Connected Components Building Blocks Overview CD, publication CC-QR001
• PanelView Component terminal
• MicroLogix 1100 or 1400 controller
• Standalone Ethernet switch so that you can connect your personal computer to both the 

MicroLogix controller and PanelView terminal over an isolated Ethernet network
• Your application containing the pre-defined alarm memory areas downloaded to the 

MicroLogix controller
19Publication CC-QS009A-EN-P - March 2009 19
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Chapter 2       System Validation and Application Tips
Follow These Steps

Configure and Validate PanelView Component Terminal to MicroLogix 
Controller Communication

The six-inch color touchscreen PanelView Component terminal communicates with the 
MicroLogix controller of the Ethernet network. The PanelView Component application reads from 
and writes to the data table of the MicroLogix controller.

The sample CCBB Alarm Handling Demo program for the PanelView Component terminal 
assumes that the static IP address for the MicroLogix controller is 192.168.100.15. If you are using 
a different IP address for the controller, the first thing you must do is modify the MicroLogix 1100 
or MicroLogix 1400 IP address in the PanelView Component application.

Start

Import the Alarm History Screen to 
the PanelView Component Terminal 

on page 22

Configure and Validate PanelView 
Component Terminal to MicroLogix 

Controller Communication on page 20

Prepare the PanelView Component 
Application to Work with Alarms on 

page 24

Testing Alarm Functionality on page 
28
20 Publication CC-QS009A-EN-P - March 2009



System Validation and Application Tips        Chapter 2
Follow this procedure to modify the MicroLogix IP address in the PanelView Component 
application.

1. Connect the PanelView 
Component terminal to 
your Internet Explorer or 
Firefox web browser by 
typing the terminal 
address in the web 
browser location bar.

2. Select the application 
name in the PanelView 
Component dashboard 
dialog box and then click 
Edit.

3. From the Edit dialog box, 
click the Communication 
navigation tab.

4. Type the IP address of 
the MicroLogix controller.

5. Click  to validate the 
PanelView Component 
application and save it.

6. Click to return to the 
Application Dashboard.

7. Click Run to run the 
application.
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Chapter 2       System Validation and Application Tips
Import the Alarm History Screen to the PanelView Component Terminal

To effectively work with alarms, you should create the Alarm History screen to show and handle 
all the alarms that occur. The screen shows all alarms chronologically. The type of alarm is 
displayed as a text message. The occurrence time and date as well as the acknowledge time and 
date are available. This screen can be prepared manually. However, you can use the prepared 
User Defined Object (UDO) to make the process more efficient.

Import the Alarm History User Defined Object

Follow these steps to import the Alarm History UDO into the PanelView Component application.

1. Launch PanelView Explorer.

2. Load the application to which you want to add the Alarm History screen.

3. Make sure that your application is stored in the internal memory of the PanelView 
Component terminal.

4. From the PanelView 
Explorer Startup 
window, click the 
File Transfer link.

5. Click New Transfer.

6. Select My Computer as the file source location and click Next.

TIP Rockwell Automation recommends using the Alarm History screen because it can improve alarm 
clearance. Using the Alarm History screen is optional. Alarm handling can work without it.
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System Validation and Application Tips        Chapter 2
7. Select User Defined Object and click Next.

8. Browse for the ‘Alarm_History.chu’ file in the Alarm 
Handling building block folder. 

9. Select Internal Storage as the file destination and click 
Transfer.

10. Go to the Application Dashboard and click Edit to 
continue working on the application.

If the current application is open, you may need to 
click Refresh in the Library Object Palette.

The Alarm History UDO appears in the Object Palette of the Library and is now ready to be used.

Add the Alarm History Screen to Your PanelView Component Application

Follow these steps to add the Alarm History Screen.

1. On the Screen List, click Add to create a new screen.

2. Name the screen ‘Alarm History’.

3. Drag and drop the previously-imported User Defined Object (UDO) to the empty Alarm 
History screen.

4. Add a navigation button. This button can be a link, for 
example, to the Main screen.

5. Add an Alarm History navigation button on the Main 
screen.

The Alarm History screen should look similar to the example 
shown here. 
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Chapter 2       System Validation and Application Tips
Prepare the PanelView Component Application to Work with Alarms

Now that you have a working project consisting of a MicroLogix controller application and a 
PanelView Component application, you can prepare your PanelView Component application to 
work with alarms. PanelView Component applications usually have several screens, one of which 
should be the Alarm History screen created in the previous section.

In this section, you will create external BOOL and REAL tags for alarm messages, create an alarm 
indicator (for the Maintained alarm handling approach), and set up the alarms.

Create External Boolean and Real Tags

1. Launch PanelView Explorer.

2. Select your PanelView Component application, which contains the Alarm screen you 
created previously and click Edit.

3. Click Tags.

4. Make sure that the External tab is selected.

5. Click Add Tag.

6. Add Alarm tags of the Boolean data type.

Alarm addresses have to correspond to the addresses used for the alarms in the controller 
application. The number of Boolean tags must be equal to the number of alarms you are 
dealing with.

7. Add Alarm tags of Real data type.

The number of Real tags must equal the number of alarms for which you want to show 
process variables embedded in the alarm text messages.

8. To make your PanelView Component application clear and readable, include a description 
for each tag you add.
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Your declared alarm Boolean and Real tags should be similar to this example.

9. Click Save Application .

Create Alarm Indicator (Maintained Alarm Handling) Buttons

Complete the steps in this section if you have chosen the Maintained alarm handling approach. In 
this approach, you are only notified that an alarm has occurred. In the Alarm Handling Demo, the 
Momentary Push Button is used as the alarm indicator. However, you can change its shape to suit 
your preferences. The button-indicator changes its appearance depending on the emerging 
alarms. If no alarm is present, the button is green and reads ‘No Alarms’. If an alarm occurs, the 
button blinks red and reads ‘Show Alarms’.

To see information about the alarms, you must press the blinking button. You can create this 
alarm button manually or import it into the PanelView Component application as a User Defined 
Object. The alarm button indicator used in the Alarm Handling Demo is called 
‘Alarm_Button_Indicator.chu’ and the file is in the Alarm Handling Building Block folder.

Follow these steps to import the prepared alarm button indicator.

1. Load your PanelView Component application.

2. Make sure your application is stored in the internal memory of the PanelView Component 
terminal.

TIP In the Standard Alarm Handling approach and the Maintained alarm handling approach, the alarm 
tags used by the PanelView Component application have to point at the bits of the B150 file in the 
controller. Real alarm tags have to point at values of F151 file for Standard alarm handling or F152 
for Maintained alarm handling.
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3. From the PanelView 
Explorer Startup 
window, click the 
File Transfer link.

4. Then click New 
Transfer.

5. Select My Computer and click Next.

6. Select User Defined Object and click Next.

7. Browse for the ‘Alarm_Button_Indicator.chu’ file in the 
Alarm Handling building block folder and click Open.

8. Select Internal Storage and click Transfer.

9. Go to the Application dashboard and click Edit to 
continue working on the application.

If the current application is open, you may need to 
click Refresh in the Library Object Palette.

The alarm button indicator User Defined Object appears in the Object Palette of the Library and is 
now ready to be used.

Follow these steps to add the alarm button indicator 
to your PanelView Component application.

1. From the Screen List, select the screen to 
which you want to add the button.

2. Go to the Library, drag and drop the button 
indicator where you want to place it.

3. Click the Tags tab.

4. Make sure you are on the External tab.

5. Add the ‘Alarms_occured’ Boolean tag and link 
it to the B151:101/0 bit in the MicroLogix 
controller.
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6. Add the ‘Show_alarms’ Boolean tag and link it to the B151:100/0 bit

7. Click the Screens tab.

8. Click the alarm-button indicator to select it.

9. Choose Properties and click Connections.

10. Make the ‘Show_alarms’ tag a Write tag.

11. Make the ‘Alarms_occured’ tag an Indicator tag.

Set Up Alarms

To set up the alarms to work within your application, follow these steps.

1. Prepare an Excel spreadsheet, like the one shown here, to describe the alarms.

• Column A = alarm trigger tag
The alarm trigger tag name should match exactly the names entered on the Tag tab and 
linked to the B150 file.

• Column B = alarm type
• Column C = edge detection, not relevant in this type of application
• Column D = value when alarm appears
• Column E = deadband level, not relevant in this type of application
• Column F = deadband mode, not relevant in this type of application
• Column G = message text of the alarm
• Column H = Ack bit (each alarm requires acknowledgement)
• Column I = Display bit (the alarm is displayed when the condition for the alarm occurs)
• Column J = Log bit (each alarm is saved in the log file)
• Column K = background color (default value is #680000 for brown)
• Column L = foreground color (default value is #FFFFFF for white)

2. Select all the populated cells in your spreadsheet and copy them to the clipboard by 
pressing Ctrl+c.

TIP
R

Rockwell Automation recommends adding alarm indicators to each working screen. To do so, 
repeat steps 8…11 on each screen. This provides you with information about alarms regardless of 
which screen is currently being used. 
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3. Go to your PanelView Component application and click the Alarms tab.

4. Press Ctrl+v to paste the spreadsheet values into the alarm list.

Your configured alarm list should look similar to the one shown here.

5. Click Validate Application .

6. Click Save Application .

Testing Alarm Functionality

Once you have imported the Alarm History screen to your application, and you have applied 
steps to prepare your application to work with alarms, you are ready to test the alarm 
functionality. If an alarm occurs, the relevant bit is set on the controller side. Since the PanelView 
Component application is linked to the application in the controller, the alarm is immediately 
visible on your PanelView Component screen. Depending upon which alarm handling approach 
you have chosen, the alarm indication appears as a system banner (Standard approach) or as a 
blinking Show Alarms button. To see the alarm message when using the Maintained approach, 
you must press the Show Alarms button.

TIP You should remove the Clear button, which is visible on the system alarm banner by default. You 
can also change the font size and appearance of the alarm banner.

Standard approach
Maintained 
approach
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You can acknowledge an alarm by pressing the Ack button. Pressing the Ack button does not 
clear the alarm condition. The system banner disappears and the alarm acknowledgement is 
noted on the Alarm History screen as well as in the Alarm Log file. You can also close the system 
alarm banner without acknowledging the alarms by pressing Close. The alarms will still be visible 
on the Alarm History screen.

Use the up and down arrows on the Alarm History screen to 
navigate through the alarms. You can acknowledge all of the 
unacknowledged errors by pressing Ack All. You can also clear 
the contents of the Alarm History screen by pressing Clear All.

The information on the Alarm History screen, including the 
alarm message, occurrence and acknowledgement times and 
dates, is also available in the Alarm Log file. Access the Alarm 
Log file from the File Transfer menu by choosing Alarm Log.
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Rockwell Automation 
Support

Rockwell Automation provides technical information on the Web to assist 
you in using its products. At http://support.rockwellautomation.com, you can 
find technical manuals, a knowledge base of FAQs, technical and application 
notes, sample code and links to software service packs, and a MySupport 
feature that you can customize to make the best use of these tools.

For an additional level of technical phone support for installation, 
configuration, and troubleshooting, we offer TechConnect Support programs. 
For more information, contact your local distributor or Rockwell Automation 
representative, or visit http://support.rockwellautomation.com.

Installation Assistance

If you experience a problem with a hardware module within the first 24 
hours of installation, please review the information that's contained in this 
manual. You can also contact a special Customer Support number for initial 
help in getting your module up and running.

New Product Satisfaction Return

Rockwell tests all of its products to ensure that they are fully operational 
when shipped from the manufacturing facility. However, if your product is 
not functioning, it may need to be returned.

United States 1.440.646.3434
Monday – Friday, 8 a.m. – 5 p.m. EST

Outside United 
States

Please contact your local Rockwell Automation representative for any 
technical support issues.

United States Contact your distributor. You must provide a Customer Support case 
number (see phone number above to obtain one) to your distributor to 
complete the return process.

Outside United 
States

Please contact your local Rockwell Automation representative for 
return procedure.

http://support.rockwellautomation.com
http://support.rockwellautomation.com
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		Details of the Rockwell Automation Print Specifications sheet

				This print specifications sheet is designed with multiple purposes.
- It is a vehicle to get the most accurate print specifications to RA-approved print vendors.
- It provides authors with an explanation of all necessary fields to complete before attaching the sheet to your PDF.
- It provides separate tabs so that an author can fill in all fields related to the publication on the Generic tab or publication-specific template-type tabs to minimize the number of fields an author must complete.

To facilitate the most efficient use of this sheet, we recommend that you click on the publication-specific tab that most closely fits you publication and use that to complete the print specifications.

IMPORTANT: Because this sheet was constructed using a sheet that RR Donnelley (RRD) uses to load print specifications, there are some columns hidden. For example, the first field you must complete is Column E, or Publication Number. Columns A to D are used for RRD purposes and with information only representatives of that RA-approved printer can complete.

DO NOT delete any hidden columns from the tab you choose to use.

		Definitions of Each Tab in Sheet

		Generic pub print specs		Single sheet with all required columns for necessary specifications. None of the columns are completed. All must be completed before attaching the sheet to your PDF.

This tab has 39 blank fields you must complete via free text type or pull-down menus.

		IN, RN pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to installation instructions (IN) and release notes (RN). However, you can use this sheet for other publications that are similar to INs and RNs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		UM, RM, PM pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to user manuals (UM), reference manuals (RM) and programming manuals (PM). However, you can use this sheet for other publications that are similar to UMs, RMs and PMs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		AP, PP pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to application solutions (AP) and product profiles (PP). However, you can use this sheet for other publications that are similar to APs and PPs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		BR pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to brochures (BR). However, you can use this sheet for other publications that are similar to BRs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		Field definitions		Description of information fields used throughout the spreadsheet tabs that may not be immediately obvious to a user.

				Attach Print Specs to PDF

				For Acrobat 8.0, follow these steps:
1. Open the PDF.
2. Click on Document>Attach A File. A new section appears at the bottom of the PDF.
3. Browse to the MS Excel file with the print specs and add it to the PDF.

For Acrobat 7.0, follow these steps:
1. Open the PDF.
2. Click on the Attachments tab next to the publication's bookmarks. A new section appears at the bottom of the PDF.
3. Click on the Add button in the bottom section of the PDF.
4. Browse to the MS Excel file with the print specs and add it to the PDF.

For Acrobat 6.0, follow these steps:
1. Open the PDF.
2. Go to the backcover of the PDF.
3. Click on the Tools pull-down menu.
4. Click on this sequence of menu options - Advanced Commenting, Attach, Attach File Tool. A paper clip appears.
5. Click to put the paper clip somewhere on the backcover. The browse window appears.
6. Browse to the MS Excel file with the print specs and add it to the PDF.

IMPORTANT: If you are using Acrobat 5.0 or earlier, please upgrade.
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IN, RN pub type specs
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AP, PP pub type specs

BR pub type specs
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The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																								EA												1		1																Black & White				B		SADDLE		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information		4								PLAIN		20#		White		RRD must provide this information		NA		NA		NA		NA		NA		NA		BLACK (preferred)						SIDE						NA		NA		NA				50		RRD must provide this information		Text Stock = 20# White Opaque Bond
Text Ink = Black



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



UM, RM, PM pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Item Description		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

										CC-QS009A-EN-P		Alarm Coordination Connected Components Building Block												EA												1		1				Marketing Commercial		CMKMKE Essential Components Program – 19041		03/04/2009								Black & White				B		SADDLE		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information		4		32		8				PLAIN		20#		White		RRD must provide this information		NA		NA		NA		NA		NA		NA		NA		8.5		11		SIDE		5/16"		3LEFT		NA		NA		NA		NA				RRD must provide this information		Cover Stock = 90# White Index
Text Stock = 20# White Opaque Bond
Cover Ink = Black
Text Ink = Black
Spine = If included as last page of PDF



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



AP, PP pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Item Description		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																								PK												1								See DocMan for the Cost Center selections associated with each Business Group.										Color				B		NA		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information										GLOSS TEXT		80#		White		RRD must provide this information		NA		NA		NA		NA		NA		NA		NA		8.5		11		NA		NA				NA		NA		HALF		8.5 x 11				RRD must provide this information



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



BR pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Cannot use quote symbol, that is--"--.		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																								PK												1								See DocMan for the Cost Center selections associated with each Business Group.										Color				B		SADDLE		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information														White		RRD must provide this information		NA		NA		NA		NA		NA				NA		8.5		11		SIDE		NA		NA		NA		NA		HALF		8.5 x 11		50		RRD must provide this information



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



Field definitions

		

		Packaging/Ordering Unit Of Measure

				EA = Each

				PK = Pack

				PD = Pad

				RL = Roll

				BK = Book

				CT = Carton

				BX = Box

				ST = Set

		Multiple Order Qty

				Separate methods of ordering same item. For example, if an item is packaged 50 per pad / 5 pads per carton. You can set the order qty as 50 each (one pad) or 250 each (1 ctn)

		Business Group

				The business group that the publication supports. Your choice here determines the list you choose from for Cost Center.

				Corporate/Business Development

				Finance

				Human Resources

				IT

				Logistics

				Manufacturing

				Marketing Commercial

				Marketing Europe

				Marketing Other

				Operations

				Order Services

				Other

				Process Improvement

				Procurement

				Quality

				Sales

		Max Order Quantity

				Presale items = 100

				Postsale items = 5

				NOTE: You can use other quantities but the delivery may take a bit longer because a system admin must approve it.

		Item Category - Form (F) or Book (B)

				Form (F) = Any publication that is a single sheet (i.e., 1 or 2 pages), an envelope or carbonless form.

				Book (B) = Any publication that contains 3 or more pages.

		Binding/Stitching

				For a Form (F) use

				CARBONLESS

				CUTSHEET

				ENVELOPE

				For a Book (B) use

				LOOSE		LOOSE -Loose Leaf

				PERFECT		PERFECT - Perfect Bound

				PLASTCOIL		PLASTCOIL - Plastic Coil (Coil Bound)

				SADDLE		SADDLE - Saddle Stitch

				STAPLED1		STAPLED1 -1 position

				STAPLED1B		STAPLED1B - bottom 1 position

				STAPLED2		STAPLED2 - 2 positions

				THERMAL		THERMAL - Thermal bound (Tape bound)

				THERMALO		THERMALO - Thermal Bound (Tape bound - offline)

				WIRE O		Wire O - Double Wire Bound (offline)

				Saddle-Stitch Items

				20 sheets max. on 20# (text and cover)

				19 sheets max. on 20# (text) and 24# (cover)

				18 sheets max. on 24# (text and cover)

				All page quantities must be divisible by 4

				Tape Bound Items

				125 sheets max. on 20# no cover

				120 sheets max. w/cover (90# index unless indicated otherwise)

				Perfect Bound Items

				475 sheets max. on 20# no cover

				470 sheets max. w/cover (90# index unless indicated otherwise)

				Double Wire Bound Items

				40 sheets max. on 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

				Coil Bound Items

				290 sheets max. of 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

		Sides Printed

				Head2Head = Most common; Double-sided printing with headers on both pages lining up at the top of the page

				Simplex = Single-sided printing

				Head2Toe = Least common; Double-sided printing with header on one page lining up with the footer on the other page

		Number of Forms to a Sheet

				Number of publication pages printed on a sheet of paper at the printer.

For example, if a 4-page, 8.5 x 11 publication is printed on the front and back sides of an 11 x 17 sheet of paper that is folded in half, the Number of Forms to a Sheet = 4.

Example 2: If a 4-page, 5.5 x 8.5 publication is printed on the front and back sides of an 8.5 x 11 sheet of paper that is folded in half, the Number of forms to a Sheet = 4.

		Number of Sheets Required to Print

				Number of sheets of paper required to print the publication.

For example, if a 16-page, 8.5 x 11 publication is printed on the front and back sides of four 11 x 17 sheets of paper that are folded in half and saddle stitched together, the Number of Sheets Required to Print = 4.

Example 4: If a 4-page, 5.5 x 8.5 publication is printed on the front and back sides of one 8.5 x 11 sheet of paper that is folded in half, the Number of Sheets Required to Print = 1.

		Paper Stock Type

						Description

				PLAIN		Bond

				ACNTCVR		Accent Cover

				BOND3H		Bond (3-hole)

				BOOKENV		Booklet Envelope

				C1SGLOSS		C1S Gloss Finish

				C1SMATTE		C1S Matt Finish

				C2SGLOSS		C2S Gloss Finish

				C2SMATTE		C2S Matt Finish

				CARD		Card Stock

				CATLGENV		Catalog Envelope

				CATLGENV#6		#6 Catalog Envelope

				COVERCOLOR		Color Cover Copy

				CRCKPEEL		Crack N Peel Label

				CUSTOM		Custom

				CVRFUTURA		Futura Cover

				ENV6x9		Standard 6X9 Envelope

				ENV9X12		Standard 9X12 Envelope

				ETHCERT		Ethicon Certificate

				GLOSSCOVER		Gloss Cover

				GLOSSTEXT		Gloss Text

				HOTSTEXT		Hots Text

				INDEX		Index

				LABEL80		80 Up Label

				MICROPRT		Micro Print

				OFFSET		Offset

				PART2		2 Part

				PART3		3 Part

				PART4		4 Part

				PART5		5 Part

				PART6		6 Part

				PERF		1/2 inch Perfed

				PERMMAT		Perm Mat Ad

				PRECUTTAB		Pre-Cut Tab

				PREPERF		Pre-Perforated

				RECYL		Recycled

				SE10ENV		#10 Standard Envelope

				SE10ITENV		#10 Inside Tint Envelope

				SE9ENV		#9 Stanard Envelope

				TAG		Tag

				TEXT		Text

				TEXTCOLOR		Text Color Copy

				TEXTFUTURA		Futura Text

				TEXTLASER		Text Laser Print

				TRANSPRNCY		Transparencies

				VELLUM		Vellum

				VELLUM3HP		Vellum 3HP

				WE10ENV		#10 Window Envelope

				WE9ENV		#9 Windor Envelope

				WE9ITENV		#9 Inside Tint Window Envelope

		Paper Stock Color

				Black

				Blue

				Buff

				Canary

				Cherry

				Clear

				Cream

				Custom

				Goldrenrod

				Gray

				Green

				Ivory

				Lavender

				Manilla

				NCRPinkCanary

				NCRWhiteBlue

				NCRWhiteBlueCanary

				NCRWhiteCanary

				NCRWhiteCanaryPink

				NCRWhiteCanaryPinkGoldenrod

				NCRWhiteGreen

				NCRWhiteGoldenrodYellow

				NCRWhitePink

				NCRWhiteWhite

				Opaque

				Orange

				Orchid

				Peach

				Pink

				Purple

				Salmon

				Tan

				Violet

				White

		Finished Trim Sizes (listed - width x length)

				11 x 17

				18 x 24 Poster

				24 x 36 Poster

				3 x 5

				36 x 24 Poster

				4 x 6

				4.75 x 7

				4.75 x 7.75

				5.5 x 8.5

				6 x 4

				7 x 9

				7.385 x 9 (RSI Std)

				8.5 x 11

				8.25 x 10.875

				8.25 x 11 (RA product profile std)

				8.375 x 10.875

				9 x 12

				A4

				A5

				Other - Custom size listed below

		Drilling Locations

				1CENTER

				1LEFTTOP

				1TOPCENTER

				2LEFT

				2LEFT2TOP

				2TOP

				2TOP2LEFT

				2TOP3LEFT

				2TOP5LEFT

				2TOP5RIGHT

				3BOTTOM

				3LEFT

				3LEFT2TOP

				3LEFT3TOP

				3RIGHT

				3TOP

				3TOP5LEFT

				5BOTTOM

				5CENTER

				5LEFT

				5RIGHT

				5RIGHT2TOP

				5TOP

				For TRI fold - select Z or C type		Description

				HALF		Half

				C		C Fold

				DBLEPARLL		Double Parallel

				OFFSETZ		Offset Z

				SAMPLE		See Sample

				SHORT		Short Fold

				V		V Fold

				Z		Z Fold

		Number of Pieces per Poly Wrap

				Publication length		Number per Poly Wrap

				77 or more pages		1

				33 to 76 pages		25

				3 to 32 pages		50

				1 or 2 pages		100

		Comments

				Cover/Text Stock		Spine

				100# Gloss Cover		If your publication uses a spine, make note of that in the comments field. Be sure to include the spine as the last page of your PDF. Do NOT include that page as part of the publication page count. Because the addition of a spine will create an odd page count in the PDF, contact a Super User to submit your publication via PDFdirect with an exception tool.

				100# Gloss Text

				100# Text

				10pt C1S Cover

				10pt C2S Cover

				10pt C2S Text

				10pt Text Stock

				110# White Index

				12pt C1S Cover

				20# White Opaque Bond

				50# Colored Offset

				50# White Offset

				50# White Opaque

				60# Cover Stock

				60# White Offset

				80# Gloss Cover

				80# Gloss Text

				8pt C1S White

				90# White Index

				Cover/Text Ink

				Black

				Black + 1 PMS color		Type in PMS color

				Black + 2 PMS colors		Type in PMS colors

				4 color

				4 color over black

				4 color + 1 PMS color		Type in PMS color

				4 color over black + 1 PMS color		Type in PMS color

				4 color + 2 PMS colors		Type in PMS colors

				4 color + aqueous

				4 color + varnish
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